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Introduction 
 
In the Auction Revolution I provide step by step 

instructions for creating fantastic eBay images.  
 

Unfortunately, shortly after I released the book, the 
software company I recommended retired, also the FTP program I 
recommend is no longer available in a free version.  
 

I rewrote the relevant sections using freeware programs, 
and decided it would be easier to just give these two sections 
to everyone, than to spend the time trying to give these pages 
only to people who have bought the Auction Revolution.   

 
Note: The image pages are numbered to correspond to the 

existing pages within the Auction Revolution. This was done so 
existing owners can print only these new pages and replace the 
relevant sections. 

 
I am not going to remove the section on using WS/FTP from 

the book because I feel it is a better program and well worth 
the small amount you'll have to pay for it. Instead I have added 
the Filezilla section as a supplement.  

 
After reading the rest of this report, you will be able to 

quickly and easily create fantastic images and host them for a 
fraction of the price you'd pay eBay for image hosting. If not 
completely free.  

 
If you are reading this and do not own the Auction 

Revolution manual, this report will acquaint you with my style 
of teaching and help you use better images in your auctions.  

 
But, this image information is only a small part of selling 

on eBay. In the Auction Revolution, you will learn a complete 
system for selling on eBay.  
  
eBay Sellers - Are common eBay selling mistakes costing you 
money?  Check your eBay knowledge now. This short quiz will help 
you earn  more money in your eBay auctions.  
  

http://www.auction-revolution.com/ 
If link does not work, 
open Internet explorer, 
then click on link. 

http://www.auction-revolution.com/
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Transferring Images From Camera To Computer 
 
Once you have taken your pictures, you will need to get 

them into your computer. If you are using a Web cam the 
pictures will already be saved onto your hard drive.  

 
If you are using a digital camera you will need to 

transfer your pictures from the camera to your computer. 
Most cameras come with cords you plug into either the 
computer’s serial port or USB port.  

 
If you haven’t already bought a camera get one with a 

USB cord. The USB is much faster than the serial cord. Your 
camera’s instruction book will explain the transferring 
procedure. 

 
A better and faster option is to use a card reader. 

Some newer computers come with built in card readers, and 
for computers without built in readers, you can get a USB 
reader for under $20. 

 
Note: there are different types of cards. Consult your 

camera’s instruction manual to insure you get the right 
type of reader for your card. 

 
The card reader is almost instantaneous. You just take 

the memory card out of your camera and insert it into the 
reader. You can then modify images right on the card or 
copy them to the drive. 

 
I edit right on the card and then save to my drive 

using a program called XnView. This image program has free 
and paid versions. You can find out more about XnView at: 
 

http://www.xnview.com 
If link does not work, 
open Internet explorer, 
then click on link. 

http://www.xnview.com/
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Editing Your Pictures 
 
Some people use Adobe Photoshop or a free program that 

came with their camera or scanner. Photoshop is too 
complicated and time consuming, while most free programs 
are too limited and hard to learn.  

 
There are also online photo editing sites. These are 

time consuming and depending on the site, can be quite 
expensive. Once you learn how to use XnView you will wonder 
why you ever considered anything else. 

 
This program only takes a few minutes to learn – You 

will be on track and ready to create fantastic images 
within a few minutes. 

 
After you have downloaded XnView and open the program 

you will get a screen like this: 
 

 

 
 
  
On the left side of the screen you can see the folders 

on my hard drive. The camera card is in the G slot and my 
camera is the 100OLYMP.  
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On the right side of the screen are thumbnails of the  
images on my memory card. Each image has the name the 
camera gave it when I took the picture. 

 
I am going to go through picture P1010048.JPG step by 

step and show you exactly how I convert the image from the 
raw camera picture to the final image I put in my auctions. 

 
Here are the steps for each image: 
 

1. Select the image by double clicking on it. 
2. Crop the image by holding down the Shift key and 

dragging the cursor from one corner of the area I 
want to another corner.  

3. Change the lighting levels if required. 
4. Resize the image by setting the maximum width. 
5. Save the image to my C drive within a folder 

called ebayimages 
 
That doesn’t sound like much work, does it. It only 

takes a few seconds to deal with each image.  
 
Here is the process in pictures:  
 
After double clicking on the thumbnail image I get this 

view: 
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By putting the cursor in just above the car and holding 

down the Shift key, I select a small area with just the car 
inside it. The next image shows the selected area. 
 
 

 
 
 
 The dotted rectangle is outer edges of the picture I 
will end up with. Remember the original picture is huge. 
1280 by 960 pixels. This is the size you want to take all 
your pictures with so they will be big even after you have 
cropped them. 
 
 The larger black dots are for changing the size of the 
selected area. Point the cursor at them until the cursor 
becomes a double ended arrow. Then hold down the left mouse 
button and move the boundary to the location you want.  
 
 The black dots in the center of each side move only the 
side they are on. The corner dots move the sides they join. 
 
 Once you have selected the area you want to keep, put 
your cursor WITHIN the rectangle and left click. A menu 
will open select crop on the menu. 
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Here’s what it looks like: 
 

 

 
  

After you select crop the program will delete the area 
outside the image and you will get an image that looks like 
this: 
 

 
 

The image is now cropped, but it is a bit dark and it's 
still much too big to use in an auction. So we will adjust 
the brightness now.   
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To brighten the background, click on Image > Adjust and 
select Conbright. Here's an image showing you the path to 
the adjustment screen. 

 

 
 
 

Once you click on Conbright, you'll get a window like 
this: 

 

 
 

With Auto View checked, move the slide bar to the right 
in order to brighten the image. If you do not like the 
changes you make click on zero. Once you have adjusted the 
colors select OK to close the color adjustment screen.  
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Note: You shouldn’t do this step very often. I 

purposely created these images so they were darker so I 
could explain this step to you. I rarely do this step 
because it is easier to set up the camera and lights to 
create an image that does not need altering. If you do 
modify the colors and hues of an image be careful you do 
not change the actual colors of your items.  

 
While XnView allows you to make other color 

adjustments, you should never change anything other than 
the brightness and contrast. Changing the gamma levels will 
result in different colors. 

 
After changing the color levels of the picture or after 

cropping the picture if color adjustment is not needed hit 
Image > Resize. 

 
This is where you set the image size in pixels. This 

will allow you to set the maximum width of your image. 
 
Here's the resize dialog box: 
 

 
 
You'll notice that I circled two areas in red. The 

upper red circle around screen size sets the maximum width 
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for your final image. Here I have entered 700. You can 
enter any number, but should keep an upper limit of 700.  

 
The lower red circle is the Keep ratio checkbox. Make 

sure this box is checked. 
 
I am sure you have seen squished images on eBay. This 

is because the people have resized them without fixing the 
ratio between height and width.  

 
Note: If you are doing images that are tall rather than 

wide, just change the height value to resize the image.  
 
All the other areas on the resize dialog box can be 

ignored. If you decide to play with the other options 
available in XnView, use images you don't need, or make 
sure you always select the save as option rather than the 
save option.  

 
Click OK and you are now ready to save your image. 
 
To open the Save picture dialog box click on File, then 

on Save As. Here’s the Save As screen: 
 

 
 
 
 I number all my images using codes I use to track my 
auctions. This little windup floor toy is number 100 of the 
series I am selling and the CT stands for my items. When I 
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do consignment items I use different letters – like CT or 
CC -to keep them separate in my book keeping. The C is 
constant and I use it on all my items. 
 
 I started using these codes because I needed some way 
to keep track of every item I sold. Ebay auction numbers 
are not generated until the auction is started so you 
cannot use them. The numbers the camera generates are 
meaningless.  
   
 I use the numbers 100 to 999 and put removable stickers 
on everything as I take photographs. Then when I write the 
descriptions, I know what the numbers for the photos will 
be.  (I do not use 1-99 because programs organize lists 
based on the first digit then the second digit if there is 
one and the number between 1 and 99 get thrown out of 
series.)  
 
 When I create more than one photo for an auction I 
number the additional images with letters like this 
ct100a.jpg, ct100b.jpg.  
 

I save all the images onto my hard drive within a 
folder called ebayimages. There are subfolders within the 
ebayimages folder. Archives is where I move the images 
after I have copied them up to web.  

 
You can create a folder on your drive by left clicking 

on your C drive in the left pane of XnView and then right 
clicking and selecting New Folder in the image preview 
area. The archive and other subfolders folders are created 
by right clicking within the ebayimages folder.  

 
The system you use to create numbers for your images 

can be different from mine. I have taught thousands of 
people how to sell on eBay and you can see many of them 
using the advice I am sharing with you in this book.  

 
One last note about naming images and we will move on 

to resizing images. Image names are case sensitive. This 
means browsers view CT520.JPG as a different image than 
ct520.jpg. In order to remove the possibility of using the 
wrong case, I strongly suggest you always name your images 
with lower case letters.  
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In the few times I have mistakenly used capital letters 

I have spent quite a bit of my time trying to figure out 
why the image wouldn’t load in the auction, only to feel 
stupid when I realize what is causing the problem. 

 
You will get very fast at cropping and renaming images. 

I can do a hundred images in less than 20 minutes. It will 
take you a while to get up to my speed, but you should be 
able to do an image in less than a minute within a few 
weeks. Remember the real goal is to have a streamlined 
system for listing lots of auctions in very little time. 

 
The system I am teaching you here is the most effective 

way to create an auction listing that builds confidence in 
your bidders and gets you the highest possible bids every 
time.  

 
You are now ready to move your images to the web. 
 
Here's the final version of the picture I used for this 

example: 
 

 
 
As a final note. I bought the toy handcar shown above 

on eBay. This is a very desirable toy, and I purchased it 
for a fraction of it's value.  
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Here's the picture the eBay seller used in his auction: 
 

 
 

Now you know how to create fantastic pictures for your 
eBay auctions quickly and easily.  

 
While I am not going to sell the rabbit - I have been 

looking for one for years for my collection - the person I 
bought him from would have gotten at least $800 dollars 
more for the handcar if he had used a better picture and 
spent the time to find the best eBay category. 

 
The auction revolution will teach you how to find items 

that are listed in the wrong category, and described 
incorrectly. You can snap these up for a fraction of their 
value and either add them to your collection, or resell 
them for a profit.  

 
This is called eBay Arbitrage. The Auction Revolution 

explains seven different ways to practice eBay Arbitrage.  
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Transferring Images To The Web With FileZilla 
 

In order to transfer your images to the web you need a 
FTP program. FTP stands for File Transfer Protocol. There 
are lots of good programs out there. Some are free; some 
you will have to pay for. I use WS/FTP LE, and find it 
quite easy to use.  

 
However some people don't want to pay for programs so 

here's instructions for a free FTP  program called 
Filezilla. 

 
You can download Filezilla at: 

 
http://prdownloads.sourceforge.net/filezilla/FileZilla_2_2_12c_setup.exe 
 
 

The first time you run Filezilla you will get a screen 
like this one: 
 

 
 

 
 
click on File > Site manager then New site and fill in 

the site details screen.  
 

http://prdownloads.sourceforge.net/filezilla/FileZilla_2_2_12c_setup.exe
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On the Site Manager screen, you need to fill in the 
Site Name, the Host Name/Address, User ID and Password.  
 
Free Space Users: 
 

If you are using free space provided by your Internet 
Service Provider use EBAY for the profile name. The Host 
Name/Address is the URL of your ISP. For example: 
www.earthlink.com, www.mindspring.com, or www.AOL.com. 

 
The user ID is the text before the @ sign in your main 

email account - USER@AOL.com, and your password is the log 
in password you selected when you created your account with 
your ISP.  

 
If you are unsure of your Host Name, User ID, or 

Password contact your ISP for this information. Some AOL 
users will have a Host Name of www.home.AOL.com or a 
variation. Contact AOL support for the address you should 
use. 

 
Leave the anonymous box unchecked and check the Save 

Password box. If you share a computer with others or use a 
Laptop you might want to check the Don't Save Password box 
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unchecked for security reasons. Jump down to the line 
Either Type of Space Users. 

 
Purchased Domain and Hosting Users: 

 
If you have purchased a domain and set up a hosting 

account, the Profile Name can be just the name of your site 
or you can use EBAY.  

 
The Host Name/Address is the url of your website. You 

do not use the http:// in the host name. Just 
www.yourdomain.com. Your web host should have sent you your 
user ID and your password when you opened your hosting 
account. Enter these in the correct fields.  Leave Host 
Type set at Automatic Detect. Check the Save password 
button, then hit Connect. 
 
Either Type of Space User: 
 
  

Filezilla will now connect to the server. Your website 
or webspace will be on the right side of the screen 
(circled in green) and your hard drive will be on the left 
(circled in red). Your screen will look like this: 

 

 
 
Actually, it won't look like that. It will have a 

section of login notes between the address bar and the site 
bar. This information is not relevant, so I have dragged 
the site information upward to cover it. To do this put 
your cursor on the bar between the login details and the 
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site information until it turns into a double headed black 
arrow. Then hold down your right mouse button and drag the 
bar upward.  

 
Note to ISP space users: You will not have all the 

selections in the left window. You will have a WWW or 
Public_html which is all you need.  

 
 

Under Filename in the red box I have drawn above find 
ebayimages and double click on it. This will open the 
folder with your images. 

 
On the remote site side (green circle) click on www 

under Filename. Your files go into the WWW folder on the 
remote server. If you do not have a WWW folder use the 
public_html folder instead.  

 
You can put your files directly into the WWW folder, 

but I suggest you create a folder on the remote server 
called ebayimages. This way all your ebay images will be in 
one place on the server and you can create other folders 
for other areas of your website or other uses.  

 
This only takes a few seconds and you only have to do 

it once. In fact, you will only have to set this whole 
system up once. Filezilla will remember the folders and 
open to them the next time you start the transfer program.  
 

To make an ebayimages folder on the server right click 
in a blank area and select create directory to create a new 
folder. (folders and directories are the same things.) 

 
 
You will get a screen asking you to enter the remote 

directory name. Replace "new folder" with  ebayimages in 
the field and hit the OK button. Then navigate to the 
ebayimages directory by double clicking on it. 

 
Now you should have your local ebayimages folder open 

in the left window, and your remote ebayimages folder 
showing in the right window. It will look like this: 
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 At this point you are ready to transfer your images to 

the web. But, before you do that you want to make sure that 
every time you start Filzilla and open the eBay connection, 
the program automatically opens to the right folders on 
both your computer and the remote server. 

 
In order to make sure you always open Filezilla to the 

relevant folders on your drive click on the advanced button 
on the site manager. That's File > Site Manager 

 
On the advanced screen enter the following locations: 
 
For Default Local: C:\ebayimages\ 
 
For Default Remote: /www/ebayimages/ 
 
Note: the direction of the slashes is different.  
 
It will look like this: 
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Then hit OK. This way you will not have to search 
through your hard drive every time you want to move images 
to the web. 

 
You are now ready to move the images up to the web.  
 
In order to move your files from your computer to the 

web just highlight them by clicking on them and then drag 
them to the remote server.  

 
Note: You can also just double click on a file to 

transfer it to the web.  
 

Hint: You can select all your images and move them up 
at once by single clicking on the top image in the left 
screen and then scrolling down to the last image and 
clicking on it with the shift button held down. Then drag 
all the selected images into the remote server pane. 
 

After you have moved your images up to the server, 
click on close to exit Filezilla.  

 
That wasn’t very hard was it? Many people avoid 

transferring images with a FTP program because they never 
spent the time to learn these simple steps. You are now 
ready to include fantastic images in your eBay listings. 
 

Note: If you are reading this report, and haven’t 
purchased the complete Auction Revolution Package, you are 
not getting the highest prices in your auctions. 
 

You see images are only one part of a successful 
auction. If you read this report for help with your images, 
chances are quite high that you are making mistakes that 
are costing you money.  
 

Perhaps you are wasting money on eBay fees for useless 
listing upgrades? Maybe you are not using adequate 
descriptions, or failing to list items in the most relevant 
category.  

 
Go to the Auction Revolution website and start 

improving your eBay selling skills now.  
http://www.auction-revolution.com/ 

http://www.auction-revolution.com/
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